Reinforced Concrete Beam: Simulation of an Experimental Test
1 Description

This example presents a numerical simulation of an experimental test on a reinforced concrete (RC) beam under increasing static load until failure. The example is test VS-C3 from the series of experiments carried out in the University of Toronto by Vecchio and Shim (2004)\(^1\). These series of tests were a reproduction of the experiments made by Bresler and Scordelis (1963)\(^2\), which are classical benchmarks extensively used for validation of numerical models for concrete structures.

The beam has a total length of 6.840 m, a depth of 0.552 m, and a width of 0.152 m. The geometry, reinforcement, loading, boundary conditions and experimental set-up are presented in Figure 1. The bottom longitudinal reinforcement is extended outside the beam and welded to thick plates. The beam exhibited a flexural-compressive failure mode [Fig. 2]. The measured peak load was \(P_{\text{exp}} = 265\) kN at a deflection of 44.3 mm.

---

\(^1\)Vecchio and Shim, *Experimental and analytical reexaminations of classic concrete beam tests*, 2004

\(^2\)Bresler and Scordelis, *Shear strength of reinforced concrete beams*, 1963
This experimental test was also simulated in Belletti et al. (2016), being a reference for the finite element model presented here.

The finite element model is 2D with plane stress elements for concrete and embedded truss elements for longitudinal and transversal reinforcement [Fig. 3]. Due to symmetry, only half of the beam is modeled. The concrete response is simulated with a total strain rotating crack model. The reinforcement steel is modeled with hardening plasticity. The steel plates for load application and support are also modeled with linear elastic material properties. Interface elements are used between the steel plates and the concrete beam. A static nonlinear analysis is performed with increasing imposed displacement until failure.

For the sake of simplicity and speed of the analysis presented in this tutorial, we use a coarser mesh and default integration settings in the elements comparing with the model of Belletti et al. (2016). In this manner we can illustrate how to model this benchmark in a relatively fast manner.

A more refined nonlinear analysis is presented in the Verification Report that is part of the User’s Manual for comparison with the experimental results in terms of load-displacement curve and cracking pattern at failure for verification of DIANA calculations. In the Verification Report an additional study is presented where different crack models are compared in the simulation of this experimental test.

---

Figure 3: Model of the Toronto beam test VS-C3

---

Most of the material properties are available in the original publication[1]. When a parameter is not specified, the value is estimated according to the Model Code 2010, following the same procedure as in Belletti et al. (2016)[3]. The material properties used in the model are listed in Table 1.

Table 1: Material properties

<table>
<thead>
<tr>
<th>Concrete</th>
<th>Reinforcement steel M10</th>
<th>Reinforcement steel M25</th>
<th>Reinforcement steel D4</th>
<th>Steel for plates</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Young’s modulus E</strong></td>
<td>34300</td>
<td>200000</td>
<td>200000</td>
<td>210000</td>
</tr>
<tr>
<td><strong>Poisson’s ratio ν</strong></td>
<td>0.2</td>
<td></td>
<td>0.3</td>
<td></td>
</tr>
<tr>
<td><strong>Compressive strength (f_{cm})</strong></td>
<td>43.5 N/mm²</td>
<td>436 N/mm²</td>
<td>600 N/mm²</td>
<td></td>
</tr>
<tr>
<td><strong>Tensile strength (f_{tm})</strong></td>
<td>3.13 N/mm²</td>
<td>445 N/mm²</td>
<td>651 N/mm²</td>
<td></td>
</tr>
<tr>
<td><strong>Fracture energy in compression (G_c)</strong></td>
<td>35.975 N/mm</td>
<td>0.1439 N/mm</td>
<td>0.05</td>
<td></td>
</tr>
<tr>
<td><strong>Fracture energy in tension (G_F)</strong></td>
<td>2.4E-9 T/mm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mass density (ρ)</strong></td>
<td>2.4E-9 T/mm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Diameter (φ)</strong></td>
<td>11.3 mm</td>
<td>25.2 mm</td>
<td>5.7 mm</td>
<td></td>
</tr>
<tr>
<td><strong>Young’s modulus E</strong></td>
<td>200000</td>
<td>200000</td>
<td>200000</td>
<td></td>
</tr>
<tr>
<td><strong>Yielding strength (f_{ym})</strong></td>
<td>315 N/mm²</td>
<td>600 N/mm²</td>
<td>651 N/mm²</td>
<td></td>
</tr>
<tr>
<td><strong>Ultimate strength (f_{um})</strong></td>
<td>460 N/mm²</td>
<td>680 N/mm²</td>
<td>0.05</td>
<td></td>
</tr>
<tr>
<td><strong>Ultimate strain (ε_{su})</strong></td>
<td>0.025</td>
<td>0.05</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

RC Beam: Simulation of an Experimental Test | https://dianafea.com
2 Finite Element Model

For the modeling session we start a new project. This is a two dimensional model and we dominantly use quadratic hexagonal elements.

Main menu ➡️ File ➡️ New [Fig. 4]
We use millimeter for the unit length and newton for force.

Figure 5: Geometry browser

Figure 6: Property Panel - units
2.1 Geometry

We start the model by making a polyline in $Y = 0$ and $Z = 0$ with the length of the beam and including the vertices correspondent to the positions of the loading and support plates; the $X$ coordinates for the vertices are [Fig. 7]: 0, 145, 220, 295, 3345, 3420.

Afterwards we extrude that line 552 mm in the $Y$ direction, that corresponds to the height of the beam [Fig. 8] [Fig. 9].

Figure 7: Geometry - Add polyline

Figure 8: Geometry - Extrude polyline
Figure 9: View of the model - beam
We do the same procedure with the support and load plates. For the support plate we create the line coincident with the beam edge and extrude it for -35 mm in the Y direction (which corresponds to the thickness of the plates) [Fig. 10] [Fig. 11]. For the load plate we create the line coincident with the beam edge and extrude it 35 mm in the Y direction [Fig. 12] [Fig. 13]. This procedure is performed to have a regular mesh.

**Main menu ➔ Geometry ➔ Create ➔ Add polyline**  
**[Fig. 10] [Fig. 12]**

**Main menu ➔ Geometry ➔ Modify ➔ Extrude**  
**[Fig. 11] [Fig. 13]**

Figure 10: Add polygon line

Figure 11: Extrude line for support plate
Figure 12: Add polygon line

Figure 13: Extrude line for load plate
Figure 14: View of the model - beam and plates for support and load
We define three lines for the longitudinal reinforcement [Fig. 1]: i) line for $2 \times M30$ bars for one level of bottom reinforcement, ii) line for $2 \times M25$ bars for other level of bottom reinforcement, iii) line for $3 \times M10$ bars for the top reinforcement.

**Main menu** ➔ **Geometry** ➔ **Create** ➔ **Add line** ➔ [Fig. 15 to 17]

Figure 15: Geometry - Add line for $2 \times M30$ bars
Figure 16: Geometry - Add line for $2 \times M25$ bars
Figure 17: Geometry - Add line ($3 \times M10$ bars)
Figure 18: View of the model - longitudinal reinforcement
We define the lines for the stirrups. Stirrups are predominantly distanced by 168 mm. This distance decreases to 52 mm in the loading and support areas (see Figure 1).

We define the first stirrup line from the bottom to the top reinforcements and at a distance of 52 mm from the edge of the beam.

![Main menu ➔ Geometry ➔ Create ➔ Add line](https://dianafea.com)  

**Figure 19: Add Stirrup 1**

**Add line**

- **Name**: Stirrup 1
- **Method**: Absolute
- **Point 1**: 52640 mm
- **Point 2**: 52502 mm
- **Distance**: 438 mm
We copy that line 4 times with a distance of 84 mm [Fig. 20]. We copy the last stirrup 17 times with a distance of 168 mm [Fig. 21]. Finally we copy the last created line twice at a distance of 84 mm [Fig. 22].
Figure 23: View of the model - transversal reinforcement
In order to be able to output cross-section forces and bending moments in the beam we use composed line elements. These elements are used for post-processing purposes only and do not have mechanical properties, so they do not influence the behavior of the model. The stresses in the elements are integrated over the cross-section plane normal to the reference line.

We create a line along the middle height of the beam to create the composed line elements.

Main menu ➔ Geometry ➔ Create ➔ Add line ✓ [Fig. 24]

Figure 24: Add line for composed elements
The geometry definition of the model is complete.

Figure 25: View of the model
We can organize the model into shape sets, so it is easier to manipulate. We create shapesets for the beam, the plates, the composed line and the longitudinal reinforcement. We create reinforcement sets for the stirrups because they have the same material and geometry properties, so we can assign the properties directly to the reinforcement set. For the longitudinal reinforcements, as they have different geometry and material properties we will make the property assignment separately for each one.

**Geometry browser** ➔ Geometry ➔ Add shapeset ➔ Beam  [Fig. 26]

Repeat for the other shape sets: Longitudinal reinforcement, Plates and Composed  [Fig. 27]

**Main menu** ➔ Geometry ➔ Create ➔ Add reinforcement set ➔ Stirrups  [Fig. 27]
2.2 Properties

2.2.1 Concrete Beam

To model the concrete we use a total strain rotating crack model with exponential softening in tension and parabolic behavior in compression. The parameters used for the definition of the material are listed in Table 1.
Figure 31: Concrete material properties

Figure 32: Concrete material properties

Figure 33: Concrete material properties
We use membrane elements with the thickness equal to the width of the beam (152 mm). We define the local element axes to ensure that these are the same in all elements.

Figure 34: Beam - edit geometry
2.2.2 Steel Plates

We assign the properties of the steel plates of the support and loading positions. Steel is linear elastic with the properties listed in Table 1.

Main menu → Geometry → Assign → Shape Properties [Fig. 35]
Shape Properties → Material → Add material [Fig. 36] → Edit material [Fig. 37]

Figure 35: Assign plates properties
Figure 36: Add new material - steel
Figure 37: Steel material properties
We also use membrane elements with the thickness equal to the width of the beam (152 mm). We add a new data for the plates to set the same integration scheme as the one used for the beam.

Figure 38: Edit geometry - plates
2.2.3 Interfaces

We include an interface between the steel plates and the beam. The element class is *Structural Interfaces* and for the material definition the properties were based on the reference [3].

Main menu  ➔ Geometry  ➔ Assign  ➔ Add connection [Fig. 39] [Fig. 40]
Edit connections  📜 ➔ Material  ➔ Add material [Fig. 41] ➔ Edit material [Fig. 42] [Fig. 43]

Figure 39: Edge selection for interface properties assignment

Figure 40: Assign interface properties

Figure 41: Add new material - interface
Figure 42: Material properties - interface

Figure 43: Material properties - interface
For the sources of the interface we choose the beam edges and for the targets we choose the plates edges. With the virtual transformation we can better see the definition of the interface; we use *Explode* tool with offset of \([0, 0, 0]\) and factor of \([1, 1.5, 1]\). We can see the source edges marked with red symbols and the target edges with blue symbols.

Figure 44: Virtual transformation
The thickness of the interface is equal to the width of the beam (152 mm). It is a line interface element.

Figure 45: Edit geometry- interface
2.2.4 Reinforcement

We now define the properties of the reinforcement. We start with the longitudinal reinforcement. There are three types of longitudinal reinforcement - M10, M25 and M30 (see Figure 1 and Table 1). We need to define the different material properties and sectional areas for each type of reinforcement. We use embedded reinforcement elements.

We start with the top longitudinal reinforcement of 3×M10 bars. We define the material properties as listed in Table 1.

**Select the correspondent reinforcement set in the Geometry browser >**

---

Figure 46: Assign reinforcement properties 3×M10 bars

Figure 47: Add new material - M10 reinforcement

Figure 48: Material properties - M10 reinforcement

---

RC Beam: Simulation of an Experimental Test | [https://dianafea.com](https://dianafea.com)
And we define the cross section of the bar as three times the area of the steel M10 ($3 \times 100.287 = 300.862 \text{ mm}^2$).

Figure 51: Add new geometry - M10 reinforcement

Figure 52: Model view - selection bar $topM10$
We assign the material properties to the bottom reinforcement of 2×M30 bars according to Table 1.

![Figure 53: Assign reinforcement properties 2×M30 bars](image)

![Figure 54: Add new material - M30 reinforcement](image)

![Figure 55: Material properties - M30 reinforcement](image)
Figure 56: Material properties - M30 reinforcement

Figure 57: Strain stress diagram - M30 reinforcement
And we define the cross section of the bar as two times the area of the steel M30 \( (2 \times 702.15 = 1404.31 \text{ mm}^2) \).

Figure 58: Add new geometry - M30 reinforcement

Figure 59: Model view - selection bar botM30
We define the bottom reinforcement of $2 \times M25$ bars. We define the material properties as listed in Table 1.

---

**Main menu** ➔ Geometry ➔ Assign ➔ Reinforcement properties ➔ [Fig. 60] Reinforcement properties ➔ Material ➔ Add material ➔ [Fig. 61] ➔ Edit material ➔ [Fig. 62 to 64]

---

Figure 60: Assign reinforcement properties
$2 \times M25$ bars

Figure 61: Add new material - $M25$ reinforcement

Figure 62: Material properties - $M25$ reinforcement
Figure 63: Material properties - M25 reinforcement

Figure 64: Strain stress diagram - M25 reinforcement
And we define the cross section of the bar as two times the area of the steel M25 \( (2 \times 498.759 = 997.518 \text{ mm}^2) \).
We now define the transversal reinforcement with stirrups of $2 \times D4$ bars. We need to define the material properties and the area of the cross section. We also use embedded reinforcements. We define the material properties of reinforcement steel $D4$ as listed in Table 1.

\[ \text{Select the correspondent reinforcement set in the Geometry browser} \]

**Main menu** ➔ Geometry ➔ Assign ➔ Reinforcement properties ➔ [Fig. 67]

Reinforcement properties ➔ Material ➔ Add material ➔ [Fig. 68] ➔ Edit material ➔ [Fig. 69 to 71]
Figure 70: Material properties - D4 reinforcement

Figure 71: Strain stress diagram - D4 reinforcement
And we define the cross section of the bar as two times the area of the steel D4 ($2 \times 25.7 = 51.4 \text{ mm}^2$).
2.2.5 Composed Line Element

We define the properties of the composed line element. We need to define the maximum distance of the elements considered for the integration of forces in the post-processing. The maximum distance is 552 mm, which corresponds to the height of the beam.

**Main menu → Geometry → Assign → Shape Properties [Fig. 74]**

**Shape Properties [Fig. 75]**

![Figure 74: Assign composed line properties](image1)

![Figure 75: Define new geometry - composed line](image2)

**Figure 76: Model view - selection composed line**
2.3 Boundary Conditions

We restrict the translation in the $Y$ direction in the mid point of the support plate.

![Figure 77: Attach support](image1)

![Figure 78: View of the model - point support](image2)
Due to the symmetry condition we restrict the translation in the $X$ direction in the symmetry edges of the beam and loading plate.

**Main menu ➔ Geometry ➔ Assign ➔ Add supports ➔ [Fig. 79]**

**Figure 79: Attach support**

**Figure 80: View of the model - symmetry support**
The load is applied by imposed deformation, so we add a support in the location of the point load with restriction in the $Y$ direction (direction of the applied load).

[Fig. 81] Figure 81: Attach support

[Fig. 82] Figure 82: View of the model - support for imposed deformation
2.4 Loads

As we impose incremental load to the beam until failure, the effects of the dead weight can be neglected.

We define the point load as a prescribed deformation of translation in the $Y$ direction with the value of -0.1 mm. We impose a prescribed deformation instead of force to replicate the experimental test that is controlled by displacements. We define a small value of displacement because we will impose small increments in the nonlinear analysis.
2.5 Mesh

We set the element size as 37.5 mm and generate the mesh.
3 Structural Nonlinear Analysis

3.1 Commands

We perform a structural nonlinear analysis until failure by increasing the load.

Figure 87: Analysis browser

Figure 88: Add command

Figure 89: Analysis browser
As we are performing an analysis until failure we don’t consider the self weight as it would have negligible influence. The point load is applied incrementally until failure by imposed deformation. Load is applied in 99 increments with a factor of 5 [Fig. 90]. We activate the arc length control to follow the path of response with automatic scale of load steps. We use the updated normal plane method with regular control, which are the default arc length options [Fig. 91]. We add a new set of control to chose the nodes and direction considered in the arc length [Fig. 92].
In the regular arc length control settings we consider the translations in the Y direction because it is the direction of loading [Fig. 92]. To control the arc length we chose the nodes of the loading steel plate, that are representative of the dominant displacement response. We could also chose the nodes of the beam.

Figure 92: Arc length control settings
In the equilibrium iteration we choose the energy convergence norm. We change the settings of the energy convergence norm from *terminate* to *continue*. We also increase the energy norm to 0.005 and set the maximum number of iterations to 20. These settings are less strict than the ones used in the reference Belletti et al. (2016)[3]. We chose them to have a fast analysis that is good enough to illustrate the problem presented in this tutorial. A more precise nonlinear analysis is presented in the *Verification Report* that is part of the *User’s Manual* for comparison with the experimental results for verification of DIANA calculations.
With the user selection we choose to output results of displacements, support reactions, crack strains and openings, total strains and stresses and forces and bending moments in the composed elements. Finally we run the analysis.

Figure 95: Analysis properties

Figure 96: Selection of results

Figure 97: Output properties
3.2 Results

3.2.1 Displacements

We start the presentation of results with the curve of applied load vs. displacement at mid span and comparison with experimental data. For that we create a graph with the reaction force versus displacement in Y direction in the bottom part of the beam at mid span.

We copy the displacement in the desired node from DianaIE to Excel.
We select the node located at middle of the support plate. We copy the reactions from DianaIE to Excel.
We make the graph in Excel. Load is the reaction force $F_{BY}$ multiplied by 2 and deflection is the displacement $TD_{tY}$ multiplied by -1. We can observe a good agreement between the numerical and experimental results.

![Graph of Load vs. Displacements](https://dianafea.com)

**Figure 104: Load vs. displacements**

Post-peak response is captured very well in a more refined nonlinear analysis presented in the Verification Report that is part of the User’s Manual.
3.2.2 Crack Widths

We represent the crack widths in the beam. For that we want to display only the mesh that belongs to the beam. We make a contour plot of principal crack width at peak load.

Mesh browser → Mesh → Shapes → Beam → Show only [Fig. 105]
Results browser → Analysis1 → Output → Element results → Crack-widths → Ecw1 [Fig. 106] [Fig. 107]

Figure 105: Mesh browser
Figure 106: Results browser
Figure 107: Crack widths at peak load

Analysis1
Load-step 85, Load-factor 424.71, Load
Crack widths Ecw1
min: -0.12mm max: 2.58mm
We observe that the computed crack pattern is similar to the experimental observation and that the failure is due to bending.

Figure 108: Crack patterns at failure: numerical and experimental results

In the Verification Report the crack patterns at failure are studied for different concrete models and crack modelling approaches.
### 3.2.3 Principal Stresses

We present the minimum principal stresses in the beam at peak load. We can observe crushing of concrete near the load application area.

![Results browser](image1)

**Figure 109: Results browser**

**Figure 110: Minimum principal stresses**

---

**Analysis1**

- Load-step 85, Load-factor 424.71, Load
- Cauchy Total Stresses S2
- min: -68.06 N/mm², max: 6.65 N/mm²
3.2.4 Longitudinal Reinforcement

We present the strains in longitudinal reinforcement at peak load. For that we show only in the mesh the longitudinal reinforcement group.

Mesh browser → Mesh → Reinforcement groups → Long Reinforcement → Show only

Results browser → Analysis → Output → Reinforcements results → Reinforcement Total Strains → EXX

[Fig. 111] [Fig. 112] [Fig. 113]
We can see that the reinforcement is yielded at peak load as the yielding strain is 2.18E-3 for M30 and 2.02E-3 for M25.

Figure 113: Strains EXX in longitudinal reinforcement
3.2.5 Transversal Reinforcement

We present the strains in transversal reinforcement at peak load. For that we hide the longitudinal reinforcement from the mesh and show the stirrups group.

Figure 114: Mesh browser

Figure 115: Results browser
We can see that the stirrups are yielded in some areas of the beam as the yielding strain is $3.0 \times 10^{-3}$.

Figure 116: Strains EYY in transversal reinforcement at peak
3.2.6 Composed Elements: Shear Forces and Bending Moments

In order to illustrate the advantage of using composed elements we output the diagrams of sectional shear forces and moments in the beam for the peak load. First we hide the stirrups and show only the line with the composed elements in the mesh.

We display line diagrams for shear forces $Q_y$ and moments $M_z$.
Analysis 1
Load-step 85, Load-factor 424.71, Load
Cross-section Forces Qy
min: -1.32e+06 N max: 1.18e-10 N

Analysis 1
Load-step 85, Load-factor 424.71, Load
Cross-section Moments Mz
min: -4.07e+06 Nmm max: -2.70e-08 Nmm

Figure 120: Cross section forces Qy

Figure 121: Cross section moments Mz
Appendix A  Additional Information

Folder: Tutorials/RCBeam

Number of elements ≈ 3100

Keywords:
  ANALYS: nonlin physic.
  CONSTR: suppor.
  ELEMEN: bar cl12i cl3cm compos cq16m interf pstres reinfo struct.
  LOAD: deform.
  MATERI: crack elasti expone harden isotro multil parabo plasti rotati soften strain totstr vonmis.
  OPTION: arclen direct newton normal regula select units update.
  POST: binary ndiana.
  PRE: dianai.
  RESULT: cauchy crack crkwdt displa force green moment princi reacti strain stress total.

References:
Disclaimer: The aim of this technical tutorial is to illustrate various tools, modelling techniques and analysis workflows in DIANA. DIANA FEA BV does not accept any responsibility regarding the presented cases, used parameters, and presented results.